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You should have opened Inkscape and be on this screen:  

             



   
Step One:  Load Strawberry File  

Click on the File menu  and then Select Import  

  

Step Two: Select File from your desktop  

You should have a screen displayed as below.  This takes 3 clicks to do.  First select Desktop, then second, 
scroll through your file list and select your strawberry file, then third, click on the open button.   

  



  
  Your screen should now look like this:  

  

Step three:  Trace strawberry file  

First select the strawberry image by clicking on it.  You should see the arrows around it.  Then second, 
Select the Path menu and then select Trace Bitmap .  

  



  
Step Four:  The Trace Window  

This takes approximately 4 clicks on this screen.  You can play around with these settings on your 
own but for the purposes of this demo do the following:  1) click on the radio button Brightness cutoff. 
Set the threshold setting to 0.350 and the other threshold setting under it to 0.300 and Colors to 8 and 
make sure all other settings are cleared out as in image below.  3)  Click on Update  button, you 
should see the strawberry show up in the window as below.  4)  Click on OK  button and then close 
the screen by clicking on the red X at the top of the screen  which will now take you back to the 
main Inkscape window.  

  

Your screen should look like this now:  

  

You have just traced an image in Inkscape!!!!!!  



 
Okay now is a good time to save your inkscape design.   

 
Inkscape is famous for locking up so always save frequently.  See illustration below to see 
how to do it:  

   

Step Five:  How to work with the Traced Strawberry Image  

Now click on the image and drag the traced image off the original image.  Your screen should look like 
this now.  

       



 
Step Six:  Setting the Display Mode to Outline  

Now select the traced image by clicking on it.    

Now click on  View menu, then click on Display Mode and then click on Outline as demonstrated 
below:   

                     



 
Your screen should look like this now:  

   

Please do not give up now.  This is where the fun part begins!!!!!!   

Step Seven:  Modify your traced strawberry image:  

Click on the edit node tool on the left hand side of your screen.  See image below:  

   



   
Now click on the traced image and your image should have changed with nodes on it.  See image below:  

   

Now with your traced image still selected click on the Shift key and the plus sign to zoom in on the image 
or you can just click on the View menu and click on  Zoom and then zoom in .   

Now your image should look like this:  

           



 
Now in this step we will delete the big hole in the strawberry.   Click on one of the nodes that form the 
circle we want to delete.  Then click on the Delete selected nodes icon as demonstrated below.  Repeat this 
process until all nodes in the circle have been deleted.  You can select all the nodes by holding down the 
shift key while selecting your individual nodes and then clicking on  Delete selected nodes icon .   

   

Now just click on the minus key to zoom out.  You now have a modified traced image of a strawberry.       

Now a decision has to be made at this point.  Do I continue to modify this file or do I want 
to create a dxf file and then load it into Robo Master and cut it out. 

  

If you decide to create a dxf file then go to Step   LAST Step:  

Otherwise go to the next step.        



 
Step Eight:  Modify Strawberry Using Make Selected nodes Smooth tool:  

With your image zoomed out and your edit nodes still on take your pointer and select the entire 
strawberry by  moving your mouse to the left top outside edge of your image and then click your mouse 
and drag down and over forming a rectangle or square around your traced strawberry.  This will 
highlight/select all your nodes.  See illustration below:  

  

Your image should look like this now:  

      



 
Now while all the nodes are selected click on Make Selected Nodes Smooth Icon.  See illustration 
below:  

  

Now click on the outer rectangle around your traced strawberry.  This will  deselect your nodes.    

           



 
Step Nine:  Modify bottom of strawberry  

Now let s zoom in again by clicking on the Shift key and the plus (+) key simultaneously.  The next thing 
we want to do is put a dimple on the bottom of the strawberry making it more realistic.  See illustration 
below:  

    

The second thing we want to do is get rid of the seeds on the strawberry that are on the bottom edge of 
the strawberry now.  First, using your mouse take your pointer and start just above the outside edge of 
the nodes you want to delete, click and drag down and over the three nodes to select them.  See 
illustration below:   

  



                         

Secondly, now you want to remove them.  Now click on the Delete selected nodes Icon.  This will 
remove them.  Repeat this step for the other 3 nodes on the bottom edge of the strawberry.  See 
illustration below:  

  



 
Now you image should look like this:  

             

Now lets take a look at our work by setting the nodes off by clicking on the outer rectangle around the 
traced strawberry and then clicking on the minus (-) key to zoom out.   

  

Your Strawberry should look like this now:  



  

You have learned so much now.  You should be very proud of yourself.                                   



 
Step Ten:  Create the strawberry stem and leaf  

Okay let s set the design mode to normal so we can work on creating the stem and leaf of the strawberry.  
Click on the View menu and then select Display mode and then select Normal.  See illustration below:    

                       



 
Your screen should look like this:  

  

Now let s zoom in on the original image of the strawberry by clicking the shift key simultaneously while 
clicking the (+) key.  What we want to do now is trace the stem and leaf of the strawberry to create 
another image.   

Your image should look like this.  

        



 
Now click on the Draw bezier curves icon.  See illustration below:  

   

Using this tool you are going to start tracing around the stem and the leaf of the strawberry.  When you 
first click the mouse it creates a tiny little square to mark your starting point.  Each time you click you 
will create a node.  Continue clicking and tracing the leaf with your pen pointer until you reach the tiny 
square and then click in the tiny square to connect the whole drawing and to release the tool.  

        



 
Now your image should look like this:  

  

Now we are going to fill the Object.  Select Object menu and then select Fill and Stroke .  See 
illustration below:  

        



The following window should be displayed:  

                                



 
Now we are going to select the Fill of our object.  Click the Fill tab and then select the solid square.  
Now you can select the type of color scheme you want to use.  I like to use the wheel so click on the 
Wheel tab.  Now you want to click on the color you want to use.  I chose black by clicking on the very 

tip of the triangle that was black.  Now click on the red (X) at the top of the screen to close the screen.     

                     



 
Your image should look like this:  

   

Now we are going to move our image off the original png file.  You will do this by selecting the Select 
and tranform objects tool on the right hand side of your screen.  Then click on the leaf image you just 
created.  Now drag the image off the original png file by holding down the right mouse button and then 
dragging it off.  See illustration below:  

        



 
Now your image should look like this:  

                                  



 
Now let s delete the original image.  Click on the original png file and then click on Edit menu and then 
click on Delete .  See illustration below:  

  

Now your screen should look like this:  

   



 
Okay now is a good time to save your inkscape design.   

 
Inkscape is famous for locking up so always save frequently.  See illustration below to see 
how to do it:  

                       



 
Step 11:  Smooth and refine the stem and leaf 

Just like we did in step eight we are going to smooth the leaf stem.  Click on the 

  
Draw Bezier 

Curve tool and then click on your leaf stem image.  You will see the nodes by doing that.  Now highlight 
all the nodes by moving your mouse to the left top outside edge of your image and then click your mouse 
and drag down and over forming a rectangle or square around your traced leaf stem.  This will 
highlight/select all your nodes.  Once they are selected then click on the Make selected nodes smooth 
icon.   See illustration below:  

  

Once you have smooth the nodes you can click on the outside of the rectangle around the leaf stem image 
and this will deselect the nodes.               



 
Now we are going to eliminate some of the nodes to make it better for the machine to cut the image out. 
This process can enhance your image or make it worse.  All you need to know is that you can always click 
on undo to get back where you were.  So again let me repeat this, if you do not like what happened when 
you deleted the node then you can click on undo to get right back to the way it was.  To undo, click on the 
Edit menu  and then click on Undo delete nodes

 
or click Cntrl key and z key.  See illustration 

below:  

   

Anywhere there are nodes that are on top of one another 

  

 or nodes piled up all together  

  

We want to try to eliminate these issues.    



  
Okay let s get started.  Select a node you want to delete then click on the Delete selected nodes icon.  
See illustration below:  

   

A rule of thumb is to delete every third node and again if you do not like what happened after you deleted 
the node then click on Undo.  You can also click on the node and move it to where it looks better.  Try it.  
When you first start moving the nodes take it slow.  I love doing this because it gives me a sense of 
POWER.  Do this until you image looks like this:  See illustration below: 

   

There are ways to make this even better but for this tutorial we will leave it alone.  



  
Oh My Goodness you have done so much now.  Please do not give up  
We are almost done!!!!!!!!!  All we have to do now is make a mat for 
the strawberry and create a dxf for robo master.     

Step 12:  Make Mat for Strawberry  

Before we make the mat let s set the fill color on the leaf stem image and the strawberry image.    

First, click the Select and transform objects tool and then second, click the leaf stem image.  See 
illustration below:  

           



 
Now select Object menu and select Fill Stroke .  See illustration below.   

   

The following screen displays.  Follow the instructions on the illustration below:  Then  click on the red 
(x) at the top of the screen to close it.  

      



 
Repeat this same process selecting the strawberry image.  Then click on the (-) key to zoom out.  

Once you have done the strawberry and  zoomed out your screen should look like this:  

  

Now we can make the Mat for the strawberry.  

Click on the leaf stem image and drag it out of the way toward the top of the screen.  Now click on the 
strawberry image and then click on Edit menu and click on Copy .  Now click on the screen where 
you want to paste your new strawberry.  Then click on Edit and then click on paste.  You now have 
another image of the strawberry.  See illustration below:  

   



 
Now your screen should look like this:  

  

Now if the second strawberry image is not selected then select it by clicking on it.  Then select Path 
menu and then select Outset .  Repeat this step 1 or 2 more times until all the seeds have disappeared on 
the strawberry.  

      



Your screen should look like this now:  

 

Okay select the newly created strawberry and set the fill color to black.  Click on Object Menu and 
then click on Fill and Stroke  and then click on Fill tab and then select black on the triangle.  

You have finished your design! 
Now is a good time to save again!!!!! 
Just click on the  icon.  Once you have named your file and saved  it once you can just click on this 
icon from then on.  

Last Step:  Save file as DXF file 
Now we can create a DXF file by clicking on File menu and then clicking on Save As .  See illustration 
below:  

    



 
The following screen should display:  Follow the directions in the illustration below:  

   

You have now finished the Part I of the Strawberry Layout tutorial.  

To cut your design load Robo Master.  Then select File and then select load DXF .  Your new design 
will display.  Once you have manipulated it to the way you want it then click save and you now have a 
new GSD file to use.     


